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1 INTRODUCTION

This document provides guidance on how to create an Office Word document to minimize the fidelity
losses while translating to DAISY xml.
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2 FEATURES

Following features will need to be used as per the guidelines given in this document for minimum

fidelity losses:

2.1.1

UID metadata

Tables

Images and Image group
Captions

XML Data

Footnotes & Endnotes
Paragraph

Lists

Headings

Page Numbers

Block Quotes

Abbreviation and Acronyms.
Side Bars

Table of content

Custom styles

MathML (Support for Mathematics)
Multiple OOXML

Language Detection

Shapes And Objects

Full Audio Support

UID METADATA [R2]

e An auto generated value will be displayed in a textbox “Document UID” on the user

interface; this ID uniquely identifies a document. User can change this value if required.

e If user deletes this value by leaving the field Document UID empty, an auto generated ID

will be populated with a prefix “AUTO-UID” and a randomly generated number.
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2.1.2 TABLES[R7]

e Complex tables in DAISY are termed as long tables crossing several pages of the print book.
Whereas, in Open XML the complex tables includes table having rows/columns merged,
table inside a table, table with background color and borders with different shading colors,
tables with page-bordering, tables with text color, table having images.

e The mapping of these complex tables from Open XML to DAISY is discouraged as it may
lead to fidelity losses. Users are encouraged to use simple tables with rows and columns.

e Simple tables with rows and columns, large tables spanning across one or more pages are
implemented with minimum fidelity losses.

e ForaTableitis advisable to use Table level cells alighment.

e Inascenario where a table is inserted in between the text, then tables will be displayed
before the text.

e Itis highly recommended to use tables for tabular data and not for layout purposes. It is
better to use styles specifically for the formatting you want to accomplish.

e Inthe translation process, headings and sidebars etc. found inside a table will be converted
to paragraphs. If you want to keep these as headings or side bars, please move them
outside the table and use the appropriate style.

2.1.3 IMAGES [R14]

e Simple images like .jpeg, .bmp, and .gif will be converted without any fidelity losses.
However, users are highly recommended to use alternate text for image/image group. If a
user is not entering alternate text for images then the output xml file will contain alternate
text attribute without any value in it.

e Complex images like image embedded in any shape object, image in a table, different
pictorial shapes like polygons, and clipart if implemented may lead to fidelity losses.

e Image groups should be implemented using a canvas. Ungrouped images inside the canvas
may lead to fidelity loss.

¢ Inthe case of embedded objects such as images, object will be copied to the destination
folder and the relationship will be set accordingly.

e Image if inserted in between the Text then Image will be displayed before the text.

H n

e Image files with “.jpeg”, “.jpe” and “.jpg” extensions will all be converted to files with “.jpg’
extension and copied to the destination folder.

e All other image files will be converted to files with “.png” extension and copied to the
destination folder.

e File names of images copied and pasted into the word document will not be retained in the
output xml and in the destination folder.

e Images which are imported from external resources will not be translated.

4
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e Caption provided above the image will not be translated. For proper
translation captions for images should be provided below the image.

2.1.4 CAPTIONS [R18]

e The captions in DAISY are tightly coupled with their respective tables/image group. In Open
XML the captions for simple images/image group/tables are loosely coupled.

e The users are highly recommended to use the captions below the image(s) for
image/image group and for the table the caption should be above the table for minimum
fidelity losses.

o Ifimages wrapped with text using other than “In line with Text” option, Captions will not
be handled.

e Caption for Grouped Images:

Users are recommended to use “Image-Caption (DAISY)” custom style for grouped images
instead of inbuilt captions.
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2.1.5 NOTES AND NOTES REFERENCES [R10]

e Footnotes will be populated at the end of the page. If the footnote is not populated at the
end of the page, it will be populated in the end of the next page otherwise it will be
populated at the end of the document.

e If footnotes containing images and shapes, Images and shapes data will be lost.

2.1.6  PARAGRAPHS [R5]

Styles like Intense Emphasis and Subtle Emphasis are not handled as it may lead to fidelity loss.
For features like Emphasis and Strong, paragraph styles Emphasis and Strong should be used.
However, users can also use Bold and Italic text styles for Strong and Emphasis features
respectively.
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2.1.7 Lists [R8]

e Numbered list will be converted as an ordered list.
e It'srecommended not to insert List of Bridgehead in a word document.
e Only the default list styles will be supported. New (Custom) list styles will not be supported.
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2.1.8 LEVELS AND HEADINGS [R4]

e Inascenario where heading appears between running text then the translated sentence
will be broken with heading information appearing as simple text.
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2.1.9

BLOCK QUOTES

Tables should not be inserted inside the Block quotes

2.1.10 ABBREVIATIONS AND ACRONYMS

Abbreviations and Acronyms are handled with Bookmark feature of the Word. All words marked
as Abbreviation and Acronyms are internally marked as Bookmark with unique name which
starts with “Abbreviations" and “Acronym” respectively. So user will see many bookmarks in the
Bookmark dialog box of word, where the name of the bookmark starts with “Abbreviations" and
“Acronym”. User should not delete these bookmarks. If user deletes the bookmark, they will be
losing the Abbreviations and Acronyms information.

User should not use the name which starts with “Abbreviations" and “Acronym” for their
bookmark.

In Word 2003 and Word XP, application uses custom document properties to store the
expansion of Abbreviations and Acronym. So user should not delete the custom document
properties, where the name of the properties starts with “Abbreviations" and “Acronym”

In Word 2003 and Word XP, User should not use the name which starts with “Abbreviations"
and “Acronym” for their custom document properties.

PAGE NUMBERS

User should not span a table across multiple pages without any text in the cell.

User should not start a new page with a blank line.

User should not start a new page with an image.

Table of content spanning multiple pages will be translated to one single page. For Example if
the Table of contents is spanning across page 3 and 4, it will be considered as the entire Table of
content in the page 3.

In multi column documents, each column in the page will be considered as a single page.
Page number with chapter number is not supported, so user should not format the page
number with chapter numbers.

Formatting the page numbers by editing the field is not supported. User should use Page
number format option for formatting the page numbers.

Only Simple type of page number from the gallery of Page number designs will be supported.
Use Simple type of Page number design.

Page numbers are handled in the best possible way, still there may be some scenarios will not
result in proper page numbers. For example
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o Some documents with empty pages (based on the user behavior) will not result in proper
page numbers.

o Ifthe document is not having the proper page break information, it will result in improper
page numbers.

e |tis highly recommended to use custom style for implementing page numbers, as the automatic
page numbers may have some issues.

2.1.12 SIDE BAR
User should follow the following steps to insert a sidebar to a word document.
The steps are explained with the help of screenshots.

e Below screenshot shows the options of Textbox highlighted after clicking on Insert tab in Tool
bar.

e Images and tables with caption inside a sidebar may lead to some information lost. So, it is
highly recommended to use custom style of caption for images and tables inside a sidebar.
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Docl.docx - Microsoft Word - 82X

References Mailings Review View Developer Accessibility

El@l @ Y= ﬂ &, Hyperlink =1 % -A -] | & Quick Parts ~ |2 Signature Line ~ || T Equation ~
e || 4 Bookmark = 2 ‘ -

|£) Cover Page ~

D Blank Page 4 WordArt @ Date & Time £2 Symbol
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¥=PageBreak | - || Art v || L# Cross-reference - > Number~ ||| Box~ AS Drop Cap = *gg Object ~
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Text Box

Insert preformatted text boxes.

~ Onthe Inserttab, the galleriesinclude items that are designed to coordinate with the overall look of
your document. You can use these galleries to inserttables, headers, footers, lists, cover pages, and
other document building blocks. Whenyou create pictures, charts, or diagrams, they also coordinate
with your current document look.

You can easily change the formatting of selected textin the documenttext by choosinga look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab. Most controls offera choice of using the look from the current
theme orusinga format that you specify directly.

To change the overalllook of your document, choose new Theme elements on the Page Layout tab. To
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your document to the original contained in your currenttemplate.

Pagei1ofl | Wordsi18s | < Engisn(us) | 2| [EEERE T e==——y=——]]

e After clicking on Textbox option a user will get the various types of Sidebars which are available.
e User can click on sidebar option and can insert it in word document.

(3)
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2.1.13 TABLE OF CONTENTS

e Word provides three types of built-in styles for Table of content. Manual Table of content is one
of the styles. User should not use this option. User should use Automatic styles of Table of
contents.

e Table of contents should not be embedded with other features of Word, like sidebars, Table cell
etc.

e Table of content is always expected to be at the first page of the word document. In case it is in
the middle of word document, even then the converted Xml will have it in First page.

e After inserting the Table of Content user should not change the contents. If they change the
content, it will produce unpredictable result.
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2.1.14 TRACK CHANGES
Before translating the word document to Daisy document ensure that

e “Track Changes” is OFF for a document.
e All changes are either accepted or rejected.

Comments:

Comments in a document may not get translated. So before translating the word document to Daisy
document ensures that document does not have comments.

2.1.15 CUSTOM STYLES

Image caption should be inserted at the Top or Bottom of an Image, if it is provided at both the places
then the resultant caption will contain both the captions concatenated.

1. Prodnote for Images (Prodnote):

e Producer Note for images should always be inserted below the image without empty spaces.
e Prodnote for images inside the block quote will not be translated.
e Producer note inserted above the Image will not be captured under <imggroup> Tag.

2. LineNumbers:

e Line numbers for a bdo (bidirectional oriented) paragraphs will not be translated.
e If line number custom style is applied for the first line of a paragraph, then empty <p> tags will
occur in the output xml file.

3. Table Footer:

e Table-Footer (DAISY) custom style is applied always to the last row of the table. This custom
style for table will automatically be updated in the Table Tools tab on click of “Import Daisy
Styles” button of the Accessibility tab as shown in the screen-shot below:
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-/E}ﬂ\ He-& = Document? - Microsoft Word Table Tools -8 X

il
——/I Home  Insert Page Layout  References Mailings Review View  Developer Accessibility Design Layout L7
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Table-Footer (DAISY)

To apply this style, user has to select a required table and click on the Table-Footer (DAISY) style and
also click on the “Table Row” check box as shown the screen-shot above.

Import Daisy Styles:

If the default styles (i.e. Default Paragraph Font, Normal, Table Normal, No List) of the document has
been changed, when importing the Daisy styles from the template to the active document, all the
default styles which are changed has been revert back to the original style. This makes the document
structure to be changed.

e To Import all the Daisy Styles from the template document to the Active document, “Import
Daisy Styles” button need to be clicked.

e There are around 35 daisy styles which need to be imported to the active document. When all
the styles are imported, “Import Daisy Styles” button should be disabled.

e If a new style has been added or any style has been deleted in the template, and if the

document which contains only the 35 daisy styles is opened, the button “Import Daisy Styles”
needs to be again enabled.
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2.1.16 MATH ML

e Equations in Word 2003/XP will be converted as Images (PNG Images).

e Reference to footnote should be made outside the equation block, as marking it inside marks
the reference also as a Math Equation.

e lLanguage support for MathML will not be provided.

e Headings and Styles should not be applied to Math Equations.

e In Command Line Utility, if Math Equations inserted through MathType software, then
equations will not be translated.

2.1.17 MuLTIPLE OOXML

e Table of Contents of Sub documents will not be translated.
e Cover pages of sub documents will not be translated.
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e Master Document should not have Anchor to a subdocument.

e Cover pages for both Master document and Subdocument will not be translated.

e Master document having subdocument should not be selected for Translating set of docs.
e While translating the set of documents, all the documents should be closed.

e Metadata information (Title, Creator etc) of sub documents will not be translated.

User should follow the following steps to create a master/sub document in respective environments.
Word XP:
Creating master document in Word XP:

1. Create a master/sub document in Word XP (.doc) format.
2. Save master/sub document in Word 2007(.docx) format.

While saving .doc file to .docx file, on click of “Save as” button the following window will be prompted to

the user.

Microsoft Word x|

P Subdocurment 'TnDocuments and Setkings),. . \ml.doc’ will be saved in a different
.4/ format, Ward can save aver the original File, or save to a different File name. Would

voul like ko save to a new file?
Mo ko Al |

¥es Yes to Al

Users are advised to choose “No” option so that the document is saved in word 2007 format, but the
extension of the document will be displayed as “.doc” in word editor, which should not be concerned..

In Word 2003 and Word XP:

Opening a Word 2003/XP document all sub documents will be closed (appear as Hyperlink) in word
editor.

On clicking “Save as Daisy” button; the following window will be displayed to the user to open the
subdocuments, User is advised to close all the documents opened before Translation.

Microsoft Word |

\_‘y Do ol wank ko open the subdocuments before cantinuing wikh this command?

Cancel |

——
& i
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If any document is left opened (Expanded hyperlink) following window will be prompted indicating some
word document is open, close the document and proceed.

Daisy Translator x|

@ Some Sub documents are in open state, Please dose all the Sub documents before Translation:

Again Click on “Save As DAISY” button the same window will appear even if all the documents are open,
it is advised to ignore the message and click on “OK” button.

Microsoft Word x|

\_?/ [ ol wank to open the subdocuments before continuing wikh this command?
Zancel |

Clicking on “OK” Button the translation process will be initiated and all the subdocuments will be

converted to single DTBOOK.xml.

Note: While translating the master document, all the sub documents should be in closed format
(Hyperlinks Unexpanded).

2.1.18 LANGUAGE DETECTION

Language feature works only at paragraph level. If user selects a part of a paragraph, the language
information will not get translated properly. So the translation would be effective if user selects the
entire paragraph or more than one paragraph.

2.1.19 SHAPES AND OBJECTS

¢ In Command Line Utility, Shapes and objects will not be translated.

e Audio Books for a document containing embedded objects will not be created. Example, a word
document is embedded inside a word document. Users are advised to create audio books
separately for the embedded documents.
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2.1.20 FuLL AUDIO SUPPORT

¢ In Command Line Utility, option for generating audio files is not supported.

e To generate the audio files from DAISY Xml through Command Line, user should use Pipeline
command line utility and it is available in Application Folder of Daisy Translator. For example, if
you have installed DAISY Translator in “C:\Program Files\Sonata\Daisy Translator Addin Version
1.5.0.0”, then the Pipeline Command Line utility named as “pipeline-lite.bat” will be located in
“C:\Program Files\Sonata\Daisy Translator Addin Version 1.5.0.0\pipeline-lite-ms”.
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